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Introduction

The UC for Enterprise (UCE) Mobility (UNIVERGE MC550) Installation
Guide provides the information you need to install, configure, and
operate the MC550.

The MC550 is a fixed mobile solution for the enterprise, delivering a
Customer Premise Equipment (CPE) based or hosted solution. For end
users, the MC550 twins with the user's enterprise telephone number on
devices of their choosing. All incoming calls are routed through the PBX
Trunks (PRI and/or SIP) to all twinned devices. This leverages the PBX
infrastructure such as call distribution, call coverage, enterprise voice
mail, call detailing recording, and least cost routing while providing
mobility. With a mobile solution, the employees will never need to give
out their mobile humber for work purposes.

The solution has no dependencies on the mobile network operator and

users, within an enterprise, can use most cellular devices which have an
enabled voice plan. MC550 also provides a web interface to make use of
enterprise presence, status, Directory, and call logs. This web interface
can be used to provide a mobile UCE experience.

) From R3, MC550 can also be used as a basic unified communications client in a
= desktop browser. In this mode, MC550 can preform call control on a users’ primary
extension, giving them access to Corporate and Personal contacts, contact lists, call
logs, and user settings all through a web browser interface. Voice twinning will work
regardless if a data plan is active for the mobile device or not.

The following topics are included in this chapter:

Chapter Topics e MC550 System Overview
e MC550 User Types Overview
e How This Guide is Organized
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1-2 Introduction

MC550 System Overview

The MC550 system allows Enterprise users to have a single point of
contact to take enterprise phone calls. By combining the use of contact
rules and the ability to ring multiple devices simultaneously, the MC550
system provides users the flexibility needed to always be in touch in
today's mobile world.

The MC550 system is composed of four major components:

OW5000 Platform

The OW5000 Platform provides the overall Database and
administration of the MC550 system. This includes providing data to
both the MC550 Server and the MC550 Status Control Web Page.

MC550 Server
The MC550 Server provides the call control features of the MC550
system, including Multi-Ringing and Voice Mail Avoidance (VMA).

MC5550 Client Service

The MC550 Client service provides desktop browsers with real time
presence updates and provides for UC function in the desktop
browser.

MC550 Web Site

The MC550 Web Site provides MC550 users the ability to have a UCE
experience while mobile; including Corporate and personal directory,
enterprise dialing, click to call from directory, contact lists, and call
logs. The MC550 Web Site also provides status change functionality.

MC550 User Types Overview

This section explains the User types available for MC550. The MC550
application is capable of integrating with UC700 to take advantage of
statuses and rules based routing. A MC550 User with uMobility and
MC550 User with uMobility and UC700 is available.

MC550 can also exist without UC700. Please see the UC700 Quick Start
Guide for more information on rules and statuses.

MC550 Users Using Contact Rules

Calls to these users use the Contact Rules to decide if a call should be
presented to mobile contacts.

This type of user can have a desk phone and up to 5 external phone
contacts and 4 internal extensions ring on incoming calls based on the
user’s contact rule.

UC700 or MC550 can be used to configure these contact rules.
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e For the mobility contacts to be presented with calls, the first contact
method must be the users Primary Extension and then the next nine
phone number contacts can also ring.

*By default, all UC700 users using MC550 are this type of user.

MC550 Users Not Using Contact Rules

e When MC550 users are not using Contact Rules, the OW5000 Location
Status Default Mobile status is used to route dual ring calls to the
Primary Extension and the current MC550 endpoint of the user.

The MC550 will only dual ring when the user is in the Default Mobile Status. Any
other status will ring the Primary Extension only.

e Advanced UCE functions, such as contacts and directory, will not be
available to these users.

e The OW5000 Administrator must assign the Location Status
Information Default Mobile status. See “Configuring the MC550
System” on page 4-1 for more information.

How This Guide is Organized

Chapter 1
Introduction

Chapter 2
Requirements

Chapter 3
Installing the MC550 System

Chapter 4
Configuring the MC550
System

Chapter 5
Advanced OW5000
Configuration

Chapter 6
Maintaining the MC550
System

Appendix A
MC550 Server PBX Settings
Details

This chapter outlines how to use the manual including the organization
and chapter layout of the MC550 Installation Guide.

This chapter outlines the requirements needed for the MC550 Server to
operate properly.

This chapter describes the necessary steps to install the MC550.

This chapter provides information on configuring the MC550 system.

This chapter provides advanced configuration steps for the MC550 Web
Site, and how to configure the OW5000 to use a secure connection to
the MC550 Status page.

This chapter includes information on maintaining the MC550 system,
including the log files.

This chapter gives specific details for each field used for the PBX
settings.
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Requirements

The MC550 Server must meet the requirements outlined in this chapter
to operate properly.

The following topics are included in this chapter:

Chapter Topics o OW5000 Platform Requirements
e MC550 Server Requirements

MC550 Web Site

PBX Requirements

LAN Requirements

OW5000 Platform Requirements

The MC550 product requires a licensed and working OW5000 platform
version R4.1 or higher. Additional requirement are listed in Table 2-1.

Table 2-1 Additional Platform Requirements

MC550/Platform Requirements

MC550 R1.0 requires OW5000 R3.3.0 or higher
MC550 R2.0 requires OW5000 R.3.3.3 or higher
MC550 R2.1 requires OW5000 R4.1

MC550 R3.0 requires UCE 2010 R2 (OW5000 R5.0)

The MC550 Web Site requires a functioning OW5000 Server and a
functioning MC550 Server. The MC500 Server must be installed prior to
the MC550 Web Site.
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MC550 Server Requirements

The MC550 Server can either be installed on the OW5000 platform
server or on a separate server. When installing on the platform server,
please refer to the Server Requirements in the UNIVERGE OW5000
Getting Started Guide.

gani The MC550 Client service will also be installed at the same time as the MC550
= Server.
NOTE

When installing on a separate server, follow the requirements listed in
Table 2-2.

MC550 Web Site

The MC550 Web Site may or may not be on the same server as the
UNIVERGE OW5000 System. If it is installed on the same server as the
platform, refer to the OW5000 Getting Started Guide for platform
requirements.

If the MC550 Web Site is installed on a separate server, the following
requirements apply (Table 2-2).

Table 2-2 MC550 Server Requirements

Operating System

Windows Server 2003 SP2 or later 32bit/64bit
Windows Server 2008 32bit /64bit
Windows Server 2008 R2 (latest Service Pack and Critical Updates)

Appropriate ports must be opened (80 or 443)
Hard Drive Space (available before installation)

2GB

Web Server

Microsoft Internet Information Server (1IS) 6.0 or higher (Windows Server 2003)
Note: IIS requires installation of the current security patches located at www.microsoft.com.
.NET Framework
NET Framework 3.5

ASP

ASP NET 2.0
SOAP

SOAP 1.2
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Server Name Resolution

The MC550 Status Page Web Site Server must be accessible by a public IP address or by a domain
name.

PBX Requirements

The following table lists the PBX requirements for the MC550 Server.

Table 2-3 PBX Requirements

UNIVERGE SV7000 UNIVERGE IPX UNIVERGE SV8500  UNIVERGE SV8300

S2 or later Supported from MC550
(OAI option is provided with
basic option in US Market) Requires R4.0 software

R26 or later R26 or later
OAl option is required OAl option is required
MC550 full functionality requires
R26e or higher S2e or higher
Other PBXs and versions are not supported. The feature of multi-ringing

stations is only supported on the UNIVERGE SV8500 running R26e, or
on the above PBXs running R27 or later.

PBX Trunking Requirements

The SV8500/SV7000/IPX trunking used to dial out to the remote
contacts must be ISDN PRI or SIP trunking. SV8300 only supports ISDN
PRI trunks for dial out to remote contacts. Other trunk types are not
supported. If necessary, a special access code can be used in the PBX to
force calls to these types of trunks. The special outbound dial Prefix
code can be specified on the PBX tab of the OW5000 > Applications >
MC550 Server page. This setting is added to the outbound number
after the OW5000 area code rules are applied.

Each remote contact dialed will use an outgoing trunk during the ringing
phase of mobility. The SV8500/SV7000/IPX/8300 must provide enough
trunks to accommodate these calls.

For the original Caller ID to be passed to the mobile contact, your
trunking provider must not screen the number sent as the calling party
number.

SV8300 does not support Caller ID pass through, or Caller ID flexibility.
On SV8300 systems, the Caller ID sent will depend upon the system
programming only.
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PBX OAIl System Requirements

The OAI facility Predictive Dial (SCF128) is used to ring the remote
contacts. There are a maximum of 255 simultaneous active Predictive
Dials per monitored number in the system.

Once the call is answered it does not count against this 255 total.

There is also a limit of 252 simultaneous Predictive Dials per Module
Group according to the grading of the trunks in the system.

Predictive Dialing is only supported on ISDN (Nortel, NI2, QSIG, ATT)
and MG-SIP type trunks in R26/S2 PBX versions or higher.

The MC550 Server uses 1 OAI association to the PBX for call control.
The SV7000/IPX and SV8500 supports a maximum of 16 OAI
associations. The SV8300 supports a maximum of 4 OAI associations.
Please see the OAI System manual for more information on OAI
associations.

LAN Requirements

In order to operate the MC550 Server application, the MC550 Server
must be able to access the LAN where the PBX is located. The MC550
Server uses TCP Port 60030 to connect to the PBX.

In order for the MC550 Web Site to operate, the web site must be
accessible from the mobile device. This normally requires that the
MC550 Web Site be accessible on the Internet with a fully qualified
domain name or IP address. This web site uses TCP Port 80 for HTTP or
TCP Port 443 for HTTPS.

The MC550 Web Site application must also be able to access the host of
the OW5000 Platform/MC550 Server. This connection uses TCPIP ports
60052 and 60053. The MC550 Web Site must also have access to the
SQL server where the OW5000 Database resides. The database
connection requires the MC550 web site server to be able to reach the
database server using UDP port 1434. This is the SQL browser port used
to inform the MC550 web site SQL client which port is used for SQL
connections. If the UDP port is unavailable, the default port of 1433 TCP
port will be used. It is normally required that both UDP port 1434 and
TCP port 1433 are open between the MC550 web site and the SQL
server.

If the MC550 Server is installed on a separate server from the OW5000,
it will need to access the OW5000 server platform. In this case, the
MC550 Server uses TCP Port 1433 and UDP port 1434 for SQL browser
support.

During the install and at application start up, TCP port 5690 must be
open from the MC550 server to the OW5000 server.
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Installing the MC550 System

Chapter Topics

This chapter describes the installation process of the MC550 System
Software.

The following topics are included in this chapter:

Before Installing the MC550 Software
PBX Configuration for MC550
SV8500 System Programming
SV8300 System Programming
Installing the MC550 Server Software
Installing the MC550 Web Site

Before Installing the MC550 Software

Before installing the MC550 software, ensure the following procedures
have been met.

¢ You are logged into an account that has administrator rights.

e The server software and hardware requirements are met, including
the installation of .NET Framework 3.5. For more information, refer to
“"Requirements” on page 2-1.

PBX Configuration for MC550

This guide assumes that all relevant PBX programming has been
completed for normal OAI operations on the PBX with the OW5000
Platform.

For more information, refer to the following material:
e OAI System Manual

¢ Command Manual

Job Specification

Feature Programming Manual

UNIVERGE OW5000 Getting Started Guide
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3-2 Installing the MC550 System

SV8500 System Programming

The following items must be configured specifically for the MC550
Server operation using the SV8500 PCPro commands.

ASYDL SYS 1
Index 1188

Index 1024

Index 869

AOKC
AKYD

AMNO/L/N

NOTE
AMNO/MLSO
% override statuses.
NOTE

Bit 1

0/1 Disable SCF128 for OAI/Enable SCF128
for OAI (Enable for MC550)

Bit O

0/1 Do not send Caller ID on Tandem Calls/
Send original Caller ID on Tandem Calls.
(Send Caller ID for MC550)

bit 0

0/1 Name data in SMFN disabled/enabled

(Enable for MC550)
Assign an OAI Key to use for the Move Call button.

Assign OAI key (Move Call button) to each MC550
user’s desk phone.

Choose, Administration Station, TN=1
AMNO=XXXX NMI =YYYY MFC=0 and do not check
the “Follow the UCD When Monitor Status is not
Requested from AP” check box.

XXXX should be a valid station level number defined
in ANPD/L/N and ASPA/L/N

YYYY should be a new unused NMI for this
application. Use LMNO to verify that no duplications
exist.

) The MC550 must have at least one Monitored number for operation.

Used by MC550.

MLSO - Mobility Location Status Override needs as many Monitored numbers as

Use the following configurations in order to receive and send caller
Name information on the ISDN/SIP trunk:

ARTD/N CDN 112 (IND) =1 (Allow incoming Name on NI-2 PRI)
ARTI/N CDN 80 (IONAME)=3 (Send outgoing Name on NI-2,

AT&T, and Nortel PRIs; Allow
incoming Name on AT&T and Nortel
PRIs)
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Often it can take a cell phone several seconds to start ringing. This is
not due to the slowness of the MC550 Server placing a call to the mobile
phone, but rather it is slowness on the part of cell phone provider
services. In order to give the MC550 user time to answer their cell
phone before their desk phone extension forwards the call to voice mail,
one should make increases to a couple of CFNA timers. There are
system wide CFNA timers configured by ASYD (SYS 1, INDEX 139 and
247), but to increase these timers per extension, use the ADAI
command to increase user's CFNA timers for INDEX 139 and 247. It is
suggested to start at 30 seconds and then decrease timers if possible
based on log entries of maximum answer times. Refer to MC550 Server
PBX Settings Details on page A-1 for more information.

SV8300 System Programming

Table 3-1 Muiltiline Terminal

Start

CM05

CM 10

Description Data
. Y:O
(1) XXZZ
Assign a Unit and Slot number to the DLC blade . .
Blade Reset|  *:01-50: Unit No.
ZZ:01-18: Slot No.
(2) 10: DLC blade

Assign the Multiline Terminal station number to | « Y=00
the associated Physical Port numbeBriade Reset| (1) XXYYZZ: Physical Port No.
Note: 1 Multiine terminal stai ) XX: 01-50: Unit No.
ultiline terminal station numbers are . .
required for MC550 support. YY. 01-18: Slot No.

1 OAl Pilot number ZZ7: 01-32: Circuit No.
1 UCD Pilot number
1 UCD Member station (2) FX-FXXXXXXXX
1 Phantom number Multiple Terminal Station No.
Note: 2 X-XXXXXXXX represents My Line No.

When DLC blade is accommodated, the
Multiline Terminal station number must be
assigned for all the lines of the blade.

Note: 3
For the following features, do not assign 5
or more digits station number.

*SMDR/PMS

*Front Desk Instrument (Multiline
Terminal)
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Installing the MC550 System

Table 3-2 Uniform Call Distribution (UCD)

Start
CM17

Description

For each UCD group, assign station numbers,
one by one, in the order of hunting.
Note: 1
Up to 60 stations can be assigned into a
single UCD group.

Example: For setting station numbers 200, 201,
202 into one UCD group.

1) 200
2) 201
1) 201
)
)

1st Operation

2) 202
1) 202
(2) 200

Note: Assign the Pilot station or Member station
to the stations included in UCD group.

Note: 2
Assign the OAl pilot number as a
monitored number.

Assign the UCD group number

Note: 3
Assign the same UCD group number to
the UCD pilot and UCD member. Assign a
different UCD group number to the OAl
monitor number.

(
(
2nd Operation (
(
(

3rd Operation

Data
+Y=0
(1) X-XXXXXXXX: Station No.

(2) X-XXXXXXXX: Another station No to be
linked

*Y=1
(1) X-XXXXXXXX: UCD Station No.

(2) 0<:Member station
1: Pilot station
3: Monitor number

*Y=2
(1) X-XXXXXXXX: Pilot Station No.
(2) 00-15: UCD Group 00-15

Table 3-3 Direct Inward Termination (DIT)

Description

CM30

Assign the station number to be terminated by

DIT in Day Mode/Night Mode/Mode A/Mode B

respectively.

Note: Assign the phantom number to all ISDN
PRI B-channels.

+ Y=04 Day Mode/05 Night Mode/ 42 Mode
A43 Mode B

(1) 000-511: Trunk No.
(2)X-XXXXXXXX: Station No.

Table 3-4 SMF Data Assignment

Start
CMo08

Description

Specify OAI SMFN (status) for Call Transfer
from a station.

Specify whether OAl SMFN is sent when
answering a held call.

Specify OAI SMFN STS (status) when a station
answers the forwarded call with Call
Forwarding-No Answer (SMFN FID=3/1).

Data
(1) 460
(2)0 :SMFN STS=7
(1) 461
(2)0 :Tosend
(1) 805

(2) 1 <: SMFN STS=1
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Table 3-5 SCF Data Assignment

Description

CM65

RR sending priority when receiving OAI SCF.

¢ Y=28
(1) 00-63: Tenant No.
(2) 0 : Send RR signal after SMFN

Table 3-6 MSF Data Assignment

Start
CM90

CMD7

Description

Assign the OAl function key for starting up MSF
to a multiline Terminal.

When pressing the OAI function key to start up
MSF, assign the operation code to the OAl
function key assigned by CM90.

Data
+Y=00
(1) My Line No. +, + Key No.
(2)F1032-F1047: OAI Function Key No. 0-15
+Y=0
(1) F1032-F1047: OAI Function Key No. 0-15
(2)128-191: Operation Code for MSF

Table 3-7 Station Hunting Assignment

Description

CME5

Set or cancel make-busy to stations

+Y=0

(1)X-XXXXXXXX:0AI Pilot/UCD Pilot/
Phantom number

(2) 0 : Make-busy set

Installing the MC550 Server Software

Step 1

Step 2

Use the following steps to install the MC550 Server software.
Place the UCE 2010 DVD into the DVD-ROM drive of the server. On

most computers Autorun automatically starts the installation when you
load the DVD. If Autorun is not enabled on the computer, you must do

the following:

—After placing the UCE DVD into the computer’s DVD-ROM drive, open
Windows Explorer and double-click the DVD-ROM drive icon.

—In the DVD-ROM file list, double-click the Setup.exe file.

From the UCE MC550 menu, select a link to launch the installer for UCE

Mobility server. Figure 3-1 displays.
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Figure 3-1 Welcome dialog box

ii.‘% MC550 Server - InstallShield Wizard

Welcome to the InstallShield Wizard for
MC550 Server

The InstaliShieldiR) Wizard will install MCS50 Server on your
computer. To continue, click Mext.

WARMIMNG: This program is protected by copyright law and
international treaties.

< Back Cancel

Step 3 Click Next. Figure 3-2 displays.

Figure 3-2 Software License Agreement

i'-.% MC550 Server - InstallShield Wizard

License Agreement

Please read the Fallowing license agreement carefully.

SOFTWARE LICENSE AGREENMENT ﬂ

NEC Corporation Chereinafter called “NEC™) grants certain license to you pursuant
to the terms and conditions of this Software License A greement Chereinafter called
the “Agreement”™) to use the softwate Chereinafier called the *Boftware™) and related
documents (hereinafter called the “Documenta™) (the Software and the Dooaments
collectively called the “Licensed Products™. As using the Licensed Products
indicates your acceptance of the following terms and conditions of this A greement,
please read them carefully before wour commencement of using the Licensed
Products. By clicking “VEZ™ and installing the Joftwate, you are assumed that you;I

PSR SSPPT FP P RPT TRPPRUTPE | JUPRPSPRT- 1S N JURNE PSPPI F- PR U SR .

" 1 accept the terms in the license agreement Print |

& 1 dn nat accept the kerms in the license agreement:

Installshield

= Back I ext = I Cancel I

Step 4 Accept the terms of the License Agreement and click Next. Figure 3-3
displays.
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Figure 3-3 Destination Folder dialog

i"v!;" MC550 Server - InstallShield Wizard

Destination Folder

Click Mext ko install to this folder, or click Change to install to a different fald

Q Install MCSS0 Server to:
CProgram Files\MECIMEC MCSE0 Server!, Change... |

Instalshield

< Back

Step 5 Click Next to install to the default folder or click Change to select a
different location. Figure 3-4 displays.

Figure 3-4 Server Name or IP Address dialog

i'é'n MC550 Server - InstallShield Wizard

0W 5000 Server
CWS000 Server Mame or IP

Please insert OWS000 Server Mame or IP Address

Installshisld

< Back I Mexk = I Cancel |

Step 6 Enter the OW5000 Server Name or the IP Address. If you are installing
on the OW5000 platform server, you can enter localhost.

Step 7 Click Next. Figure 3-5 displays.
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Figure 3-5 Server Install dialog box

i'é‘- MC550 Server - InstallShield Wizard

Database Server

Select database server and authentication method

Database server that you are installing to:

j Erowse, ., |

Connect using:

" wWindaws authentication credentials of current user

{* Server authentication using the Login ID and password below

Login ID: |openw0rxdb

Password: I LTIy

Mame of database catalog:

Jowsoon Browse... |
Instalshield
= Back | Mext = I Cancel I

If localhost or the server name was specified in the previous step, the
database information and credentials will be filled in automatically, as
shown in this example. Normally, no changes will need to be made.

Step 8 Click Next and then follow the prompts to install the MC550 Server.

Activating the MC550 Server Software
The MC550 Server software is normally activated with the platform. If it
does not activate, use the steps below.

Confirming License Activation
Follow the steps below to confirm that the licenses are activated.

Step 1 In OW5000 Administrator, go to OW5000 > Platform > Licenses page
and select the Licensed Information tab. A screen displays the total
licenses available and all Used Licenses.

If you are using a Trial License, the expiration date is indicated under
Term of Validity.
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Upgrading the MC550 Server

When upgrading from R1 or R2 to R3, select Control Panel > Add Remove
= Programs and remove the MC550 Server before installing the new server.

Step 1 Place the UCE 2010 DVD into the DVD-ROM drive of the server. On
most computers Autorun automatically starts the installation when you
load the DVD. If Autorun is not enabled on the computer, you must do
the following:

—After placing the UCE DVD into the computer’'s DVD-ROM drive, open
Windows Explorer and double-click the DVD-ROM drive icon.
—In the DVD-ROM file list, double-click the Setup.exe file.

Step 2 From the UCE Mobility menu, select a link to launch the installer for
MC550 Mobility Server. Figure 3-6 displays.

Figure 3-6 Upgrading the MC550 Server

MC550 Server X

‘?/ This setup will perform an upgrade of ‘M550 Server', Do wou want bo conkinue?

Step 3 Click Yes to upgrade or No to cancel the process.

Uninstalling the MC550 Server

Step 1 Place the UCE 2010 DVD into the DVD-ROM drive of the server. On
most computers Autorun automatically starts the installation when you
load the DVD. If Autorun is not enabled on the computer, you must do
the following:

—After placing the UCE DVD into the computer’s DVD-ROM drive, open
Windows Explorer and double-click the DVD-ROM drive icon.

—In the DVD-ROM file list, double-click the Setup.exe file.

Step 2 From the UCE MC550 menu, select a link to launch the installer for UCE
Mobility server to display Figure 3-7.
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Figure 3-7 Program Maintenance

{i& MC550 Server - InstallShield Wizard

Program Mainkenance

Madify, repair, or remove the program.

Change which pragram Features are installed, This option displays the
Custom Selection dialog in which vou can change the way Features are
installed.

Repair installation errors in the program. This option fixes missing or
corrupk Files, shorbcuts, and reqgistry entries,

. Remove

@ Remove MCSS0 Server From wour computer,
% |

Installshield

< Back, I Next = I Cancel |

Step 3 Select the Remove radio button and then click Next. The MC550 Server
is removed from your computer.
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Installing the MC550 Web Site

Step 1

Step 2

Place the UCE 2010 DVD into the DVD-ROM drive. On most computers
Autorun automatically starts the installation when you load the DVD. If
Autorun is not enabled on the computer, you must do the following:

—After placing the UCE DVD into the computer’s DVD-ROM drive, open
Windows Explorer and double-click the DVD-ROM drive icon.

—In the DVD-ROM file list, double-click the Setup.exe file.

From the UCE Mobility menu, select a link to launch the installer for

MC550 Mobility Client Website. Figure 3-8 displays.

Figure 3-8 MC550 Client—Destination Folder dialog box

i'._% MC550 Client - InstallShield Wizard

Welcome to the InstallShield Wizard for
MC550 Client

The InstallShield{R) Wizard will install MCSS0 Client on vour
computer, To continue, click Mext,

WARMIMG: This program is protected by copyright law and
international treaties,

=
Fra

|
a

< Back Cancel

Step 3 Click Next. Figure 3-9 displays.

Figure 3-9 License Agreement dialog box

i'._% MC550 Client - InstallShield Wizard

License Agreement

Flease raad the Following license agraement carefully,

NEC Corporation chereinafter called “NEC™) grants certain license to you pursuant
to the terms and conditions of this Software License Agreement (hereinafier called
the “Agreement™) to use the software Cheremnafier called the “Software™) and related
documents (hereinafter called the “Documents™ (the Software and the Documents
collectively called the “Licensed Products™. As using the Licensed Products
indicates ywour acceptance of the following terms and conditions of this A greement,
please read them carefully before your commencement of using the Licensed

— PP LY SRR Y FE U R PR

¢ T accept the berms in the license agreement;

€~ 1dn not accept the terms in the license agreement

InstallStield

SOFTWARE LICENSE AGREEMENT i’

Products. By clicking “YE3” and installing the Software, wou are assumed that youLI

Prink |

I [Mexk = I

< Back. Cancel
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Step 4 Accept the terms of the License Agreement and click Next. Figure 3-10
displays.

Figure 3-10 Destination Folder dialog box

i‘é‘- MC550 Client - Installshield Wizard

Destination Folder

Click Mext toinstall ko this Folder, ar click Change ko install to a different Fald

G Inskall MCES0 Client bo:
C:\Program Files\WECMEC M550 Clisntl, change. .. |

Installshisld

< Back Cancel |

oo oo S

Step 5 Click Next to install to the default folder or click Change to select a
different location. Figure 3-11 displays.

Figure 3-11 MC550 Server dialog box

i"w!;" MC550 Client - InstallShield Wizard | x|
MLC550 Server

MCS50 Server Name or IP

Please insert MCSS0 Server Mame or IP Address,

Inistall=hield

< Back

Step 6 Enter the MC550 Server Name or the IP address. If installing on the
MC550 server, you can enter localhost.

Step 7 Click Next. Figure 3-12 displays.
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Figure 3-12 Ready to Install dialog box

|§ MC550 Client - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation.

Click Install ko beqin the installation,

If vou want ko review or change any of vour installation settings, click Back. Click Cancel ta
exit the wizard,

Installshield

= Back Cancel I

Step 8 Click Install. An Installing dialog box displays briefly and then
Figure 3-13 displays.

Figure 3-13 Installation Complete dialog box

& MC550 Client - InstallShield Wizard

InstallShield Wizard Completed

The Installshield Wizard has successfully installed MCSS50
Clignk, Click Finish to exit the wizard,

Canicel

= Back

Step 9 Click Finish to complete the Client installation process.
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Securing the MC550 Web Site

Users will log on to the MC550 Website by submitting their UC700 logon
credentials. It is strongly recommended to configure IIS for this MC550
web site application to only support SSL connections.

Instructions on how to configure SSL and only allow SSL on a web
application can be found on Microsoft's web site. The MC550 training
material will provide the user the steps needed to accomplish this task.

Upgrading the MC550 Client

gsnas) When upgrading from MC550 R1 to MC550 R2, select Control Panel > Add

= Remove Programs to remove the MC550 Client Website and then install MC550 R2
Client Website.

Step 1 Place the UCE 2010 DVD into the DVD-ROM drive of the server. On
most computers Autorun automatically starts the installation when you
load the DVD. If Autorun is not enabled on the computer, you must do
the following:

—After placing the UCE DVD into the computer’s DVD-ROM drive, open
Windows Explorer and double-click the DVD-ROM drive icon.
—In the DVD-ROM file list, double-click the Setup.exe file.
Step 2 From the UCE MC550 menu, select a link to launch the installer for

MC550 Mobility Client Website Install to begin the upgrade process.
Figure 3-14 displays.

Figure 3-14 Upgrading the MC550 Client

MC550 Client X

‘?/ This setup will perform an upgrade of 'MCS50 Client'. Do you want ko continue?

Step 3 Click Yes to upgrade the MC550 client or No to cancel the process.
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Uninstalling the MC550 Client

Follow the steps below to remove the MC550 Client from you computer.

Step 1 Place the UCE 2010 DVD into the DVD-ROM drive of the server. On
most computers Autorun automatically starts the installation when you
load the DVD. If Autorun is not enabled on the computer, you must do
the following:

—After placing the UCE DVD into the computer’s DVD-ROM drive, open
Windows Explorer and double-click the DVD-ROM drive icon.
—In the DVD-ROM file list, double-click the Setup.exe file.
Step 2 From the UCE MC550 menu, select a link to launch the installer for

MC550 Mobility Client Website Install to begin the uninstall process.
Figure 3-15 displays.

Figure 3-15 Uninstalling the MC550 Server

i'é’- MC550 Client - InstallShield Wizard

Program Maintenance

Modify, repair, or remowe the program,

" Modify

Change which program Features are installed, This option displays the
Zustom Selection dialog in which vou can change the way Features are
installed.

Repair inskallation errars in the program., This option fixes missing or
corrupt files, shorkcuks, and reqistry entries,

Remave MICS50 Client From your computer,

Installshield

< Back I Mext = I Cancel |

Step 3 Select the Remove radio button and then click Next. The MC550 Server
is removed from your computer.
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Configuring the MC550 System

This chapter describes the configuration process for the MC550 System
Software.

OW5000 Administrator is used to configure many of the MC550 System
items. It is a robust OW5000 tool used to configure applications, PBX
configurations, and utilities without using the Windows registry editor
directly. It also provides a graphical user interface to modify OW5000
user account information, PBX configurations, and database entries.

Refer to the OW5000 Configuration Guide for detailed instructions on
how to add or modify users, people, extensions, applications, or for
more details on configuring PBXs.

The functions and associated screen displays for configuring the MC550
System in OW5000 Administrator are described in this chapter.

The following topics are included in this chapter:

Chapter Topics e Configuring the MC550 Server in OW5000 Administrator
e Configuring MC550 Users
e Configuring Extensions

Configuring the MC550 Server in OW5000 Administrator

Before starting the MC550 Server process for the first time, ensure the
following four items are completed.

e Assigning a PBX / Monitored Numbers

e MC550 Server Settings

e [ocation Status Information/Message Settings

e Starting the Services

UCE Mobility (UNIVERGE MC550) Installation Guide - Revision 4



4-2

Configuring the MC550 System

Logging into OW5000 Administrator

Each time you work with OW5000 Administrator, log in with your
OW5000 login ID and password. If this is the first time you are logging
in to the OW5000 Administrator, use the default login ID admin and the
default password for admin is admin.

Step 1 From the desktop, click the Start button and then select All Programs >
NEC OW5000 > OW5000 Platform > OW5000 Admin. Figure 4-1
displays.

Figure 4-1 OW5000 Admin Login screen

NEC 805555

OW5000 Administrator

Login ID:
Passwaord:

Step 2 Enter your login ID in the Login ID field.

The default login ID is admin.

Step 3 Enter your password in the Password field.

The default password for admin is admin.

After the initial login, you are required to change your password.

Step 4 Enter your Login ID.

Step 5 Enter a new password in the New Password field.The length of the
password must be at least eight characters long and include the
following rules:

—1 Uppercase letter (A-Z)
—1 Lowercase letter (a-z)
—1 Digit(1-9)

—1 Special Character (excluding a space, square brackets, backslash,
and single or double quotes)

Step 6 Enter the new password again in the Confirm New Password field.

Step 7 Click Login. Figure 4-2 displays.
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Figure 4-2 OW5000 Platform Main Menu

NEC §wso

o

OWS000
Platform

Applications

Directory

Application Data
Settings

Scheduler
Templates

MA4000 Integration
Version Information

Assigning a PBX / Monitored Numbers

Step 1 From the OW5000 Platform Main Menu (Figure 4-2), select Platform >

PBXs to display Figure 4-3.

If PBXs have previously been added, a list of all configured PBXs

displays.

Figure 4-3 Selecting or Adding a PBX
NEC §¥:555

Log Qut

OWS000  Unified Communications

PBX Management

1-30f3records|zn | Results per page

PBX Name 4 IP Address Office Code
J @ FPCT 1722413248 555
J @ FPCH 1722445247 888
J @ FRCT 1722443220 7

1-30f3records|zn | Results per page

PBX Type
UNIVERGE NEAX2400 IPH

UNIVERGE NEAX2400 IPX
UNIVERGE NEAX2400 P

Split Call Forward

HEE

Pagelt  |Eof

RMI Bind Name
OAlServer FPCT
OiServer FPC3
QiServer FPCT

Pagelt  |Eof

Step 2 Select the desired PBX to use for mobility users and then click the
Pencil # Icon or click Add New PBX and follow the steps below.

Figure 4-4 displays.
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Figure 4-4 PBX Management—Reserved Number dialog box

PBX Management

& Quick Links
Current: AcdPBX

Extension

PBX Settings Locations AreaCode Rules PBX — PBX Dialing Reserved Numbers Voice Mail Pilot Numbers

ored Number

0 | Results per page

Page|1  [Bof1

Monitor Number Reserved Type Tenant Owner

4800 Honitored Number 1 Incoming Call Assistant
4801 HMonitored Number 1 Location Status

4802 Monitored Number 1 Mobik Clent

1-30f3records (20 |E Resulls per page

Page[1 o1

Step 3  Select the Reserved Numbers tab and click Add New Monitored
Number. Figure 4-5 displays.

A monitored number must be assigned. This number corresponds to the
SV8500/SV7000/IPX command AMNO and SV8300 CM 172 set to 3.

Figure 4-5 Reserved Number dialog box

PBX Management

& Current: SV7000-LAB44
PBX Settings

Locations AreaCode Rules PBX — PBX Dialing Reserved Numbers Voice Mail Pilot Numbers

PBX: SV7000-LAB44

S —

* Reserved Type: | Monitored Number hd
Application: | Un-assigned -

The PBX name is displayed for informational purposes only and cannot
be changed.

Step 4 Enter the number to reserve in the Number field.

Step 5 Enter the Tenant for this reserved number.

Step 6 Select Monitored Number for the Reserved Type from the drop-down
list.

Step 7 In the Application field, select Mobility Client.

Step 8 Click Apply.
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Assigning a PBX / Mobility UCD Member

A Mobility UCD Member is only needed on the SV8300.

Step 1 From the OW5000 Platform Main Menu (Figure 4-2), select Platform >
PBXs to display Figure 4-6.

If PBXs have previously been added, a list of all configured PBXs
displays.

Figure 4-6 Selecting or Adding a PBX
NEC 8¥5855 Loaou

FBX Managemsnt

1-30f3records|zn | Results per page Pagelt  |Eof

PBX Name 4 IP Address Office Code PBX Type Split Call Forward RMI Bind Name
J @ FPC1 1722413248 555 UNIVERGE NEAX2400 IPX B OAlServer FPCT
J @ FPC3 1722413247 56 UNIVERGE NEAX2400 IPx Il OiServer FPC3
J & FPCT. 1722413220 keel UNIVERGE NEAX2400 IPX ] QaZerver FPCT

1-30f3 records[z0_ | Results per page Page1  |@urt

Step 2 Select the desired PBX to use for a Mobility UCD Member and then click
the Pencil # Icon or click Add New PBX and follow the steps below.
Figure 4-7 displays.

Figure 4-7 PBX Management—Reserved Number dialog box

PBX Management

a) Quick Links
Current: AcdPBX

Extension

PBX Settings Locations AreaCode Rules PBX — PBX Dialing Reserved Numbers Voice Mail Pilot Numbers

1-3of3records[20 B Results per page Pageid  [Eoft

Monitor Number Reserved Type Tenant
4800 Montored Number

7
J & 4801
J &

4802

1-3of3records[20 B Results per page Pageii  [Eoft

Step 3 Select the Reserved Numbers tab and click Add New Monitored
Number.

A monitored number must be assigned. This number corresponds to the
SV8300 CM 172 set to 3. Figure 4-8 displays.
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Figure 4-8 Reserved Number—Mobility UCD Member dialog box

PBX Management

a) Quick Links
Current: AcdPBX

Extension

PBX Settings cations AreaCode Rules PBX — PBX Dialing Reserved Numbers Voice Mail Pilot Numbers

PBX: AcdPBX

* Number |

*Tenant: [1 =
* Reserved Type: [Mobility Ucd Member |~
Application: [\abile Client [~

Apply & Add New J§  Apply Cance

The PBX name is displayed for informational purposes only and cannot
be changed.

Step 4 Enter the number to reserve in the Number field.
Step 5 Enter the Tenant for this reserved number.

Step 6 Select Mobility UCD Member for the Reserved Type from the drop-
down list.

Step 7 In the Application field, select Mobile Client.
Step 8 Click Apply.

Assigning a PBX / Mobility UCD Pilot
P A Mobility UCD Pilot is only needed on the SV8300.

—_—) —

Step 1 From the OW5000 Platform Main Menu (Figure 4-2), select Platform >
PBXs to display Figure 4-9.

If PBXs have previously been added, a list of all configured PBXs
displays.

Figure 4-9 Selecting or Adding a PBX

INIVERGE
NEC 3585 Lo
OW5000  Unified Communications

PBX Management

13 of 3 records [z | Results per page Pagel1  |@of1
PBX Name & 1P Address Office Code PBX Tyne Split Call Forward RMIBind Name
y g FPC1 17224.132.48 555 UNIVERGE NEAX2400 IPX (| OAlServer f FPC1
ﬂ g FPC3 1722413247 566 UNIVERGE NEAX2400 IPX r OAlServer f FPC3
m FPCT 17224132.20 wT UNNVERGE NEAX2400 IPX r OAIServer. FPCT
1-30f3 records|20 | Results per page Pagel1  |@of1
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Step 2 Select the desired PBX to use for Mobility UCD Pilot Members and then
click the Pencil 4 Icon or click Add New PBX and follow the steps
below. Figure 4-10 displays.

Figure 4-10 PBX Management—Reserved Number dialog box

PBX Management

& Quick Links
Current: AcdPBX

Extension Management

Locations | AreaCode Rules Reserved Numbers [T EREWE I, WL

PBX Settings PBX — PBX Dialing

Add New Monitored Number

1-3 of 3 records 20 |8 Resutts per page Fag‘E;W Bort
Monitor Number Reserved Type Tenant Owner

J i 4300 Monitored Number 1 Incoming Call Assistant

; it 4801 Monitored Number 1 Location Status

f i} 4802 Monitored Number 1 Mobik Client

1-3 of 3 records 20 |8 Resutts per page Fag‘E;W Bort

Step 3 Select the Reserved Numbers tab and click Add New Monitored
Number.

A monitored number must be assigned. This number corresponds to the
SV8300 CM 172 set to 3. Figure 4-5 displays.

Figure 4-11 Reserved Number—Mobility UCD Pilot dialog box

PBX Management

& Quick Links
Current: AcdPBX

Extension

PBX Settings Locations AreaCode Rules PBX — PBX Dialing Reserved Numbers Voice Mail Pilot Numbers

PBX: AcdPBX

*Tenant: |1 ¥

* Reserved Type: [TV Ry

yUc
Application: [\lobile Client -

The PBX name is displayed for informational purposes only and cannot
be changed.

Step 4 Enter the number to reserve in the Number field.
Step 5 Enter the Tenant for this reserved number.

Step 6 Select Mobility UCD Pilot for the Reserved Type from the drop-down
list.

Step 7 In the Application field, select Mobile Client.
Step 8 Click Apply.
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MLSO Reserved Numbers

Telephony Base Remote Status Change

Follow the steps below to assign reserve numbers for use by MC550 to
allow users to change their location status by dialing specific numbers.

gonss Repeat the steps for each status made available for the users.

These numbers will then be mapped on the MC550 allowing the Mobility
user to call a predefined number to change their status.

Step 1 From the OW5000 Platform Main Menu (Figure 4-2), select Platform >
PBXs to display Figure 4-12.

If PBXs have previously been added, a list of all configured PBXs
displays.

Figure 4-12 Selecting or Adding a PBX

INIVERGE
NEC §W55 Loaout
OWS000  Unified Communications

FBX Managemsnt

1-30f3 records[z0_ | Results per page Page1  |@urt

PBXName 4 P Address office Coue PBX Tvne Salit Call Forward EMIEind Name
w FPCT 1722413248 555 UNNVERGE NEAX2400 IPX r O&|Server FPCT
ﬁ g FPC3 1722413247 BEE UNINERGE NEAX2400 IPX r OAlServer FPC3
ﬂ g FPCT 17224132.20 i UNIVERGE NEAX2400 IPX r OAlServer FPCT
1-3of3records(z0 |6 Results per page Pagelt  |Eof

Step 2 Select the desired PBX to use for Mobility L.S. Override and then click
the Pencil /# Icon or click Add New PBX and follow the steps below.
Figure 4-13 displays.

Figure 4-13 PBX Management—Reserved Number dialog box

PBX Management

& Quick Links
Current: AcdPBX

Extension Management

PBX Settings | Locations | AreaCode Rules | PBX — PBX Dialing WENELNITTECE Voice Mail Pilot Numbers

Add New Manitored Number

1-3 03 records[20 B Results per page Page(1 @oft
Monitor Number Reserved Type Tenant Owner

f f 4300 Wontored Number 1 Incoming Cal Assistant

; o 4801 Monitored Number 1 Location Status

i i 4302 Wontored Number 1 Mobie Cient

1-30f3 rewrdsl_zo_\ Results per page Pagel1  @of1

Step 3 Select the Reserved Numbers tab and click Add New Monitored
Number.
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A monitored number must be assigned. This number corresponds to the
SV8500/SV7000/IPX command AMNO and SV8300 CM 172 set to 3.
Figure 4-14 displays.

Figure 4-14 Reserved Number—Mobility L.S. Override dialog box

PBX Management

& Current: AcdPBX

PBX Settings ocations. PBX — PBX Dialing [EEEEOECTILTEYS  Voice Mail Pilot Numbers

PBX: AcdPBX

The PBX name is displayed for informational purposes only and cannot
be changed.

Step 4 Enter the number to reserve in the Number field.
Step 5 Enter the Tenant for this reserved number.

Step 6 Select Mobility L.S. Override for the Reserved Type from the drop-
down list.

Step 7 In the Application field, select Mobile Client.
Step 8 Click Apply.

MC550 Server Settings
Follow the steps below to configure the MC550 Server setting.

Step 1 From the OW5000 Platform Main Menu (Figure 4-2), select
Applications > MC550 Server (Figure 4-15). A PBX Settings dialog box
displays (Figure 4-16).

Figure 4-15 MC550 Server dialog box

OWS5000 UA5200 Unified Communications

Platform

Applications » Access Server

Directory r  ACD

Application Data Application Message Service
Settings Dialer

Scheduler Email Notification

Templates Incoming Call Assistant

MA4000 Integration Location Status Information
Version Information MC550 Server

DAl Server

Remote Call Control

Use the steps below to configure PBX Settings and User Settings.
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PBX Settings

Figure 4-16 PBX Settings dialog box

MC550 Server

PBX Settings User Settings

FBX | Danafbx '—I
IP Address 1722413238
PBXID: 222
RMI Bind Mame: OAlServer Dans-Phx
Client Server Port 44012
PBX Type: UNIVERGE SVEE00
Split Call Forward: Mo
Port: 80020
Foroe Port Yes
Heartbeat Yes
Selected [#
Use OAl Server No

Dsta Mode: | 122 Mbility |
LED Numbar [ 12 Masility =]

Database Refresh Timer {min} 1 |{DEfsuIt\:sIuE Smin)
VMMA Short Timer {sect 2 | value 2-8sec)
VMMA Long Timer (sect 28 | {Suggested value 15-40 sec)

SMFN Version: § | {Defaultvalue 2)

Specisl Cutbound Dial Frefix |

Default Cutbound Caller I0: |

Send Caller |0 for Qutbound Diak ¥

Calling Mame Override from Database: ¥

Telephony Status Change Sucoess |
A cement

Telephony Status Change Failure |
Announcement

RESERVED LINE SETTING S

Dial 2500: (2142620150 [t Luncn =
Dial 2501: (2142620151 |Away from Desk =]
Dial 2502 [2142620152 | Jeusy -l
Dial 2503 [2142800152 [Gone Home 7]
Disl 2504 [214262015412245" | [On Business Trip =]

PR3 Please refer to A for detailed descriptions of each setting.

=y

NOTE

Step 1  Select the desired PBX from drop-down menu, then set the Selected
check box.

Step 2 Select the Mode number to use for this PBX's Move Call key (same as
AOKC OP-CODE).

Step 3 Select the LED number used for this PBX's Move Call Key (same as
AOKC Key Number).

Step 4 Enter 3 as the VMMA Short Timer (Sec) value.
Step 5 Enter 32 as the VMMA Long Timer (Sec) value.
Step 6 The SMFN Version should be 2.

UCE Mobility (UNIVERGE MC550) Installation Guide - Revision 4



Configuring the MC550 System 4-11

—The VMMA timers and SMFN Version are initial values and should be
adjusted depending on the user network settings. This must be tested
at the time of the installation. The Selected box should also be
checked so the system knows this PBX is active in the MC550 system.

User Settings

Select the User Settings tab from the PBX Settings dialog box
(Figure 4-16) to display Figure 4-17.

Figure 4-17 User Settings dialog box

MC550 Server

PBX Settings User Settings Quick Links
Person Management
Filter - Autharization: | Al ~] Search By - [First Name =] [Starts with ]
1-100f 13 records[1g_ | Resulls per page Page[1  |@of2 » >
First Name & Last Name Loain Authorizationtame
s Administrator Adminstrator admin
g Brian Griffin barifin
g Cleveland Brown corown
J Dana Pope: dpope
7 et Agnew Jagnew
s los Smith foe
g Jon Lacy Jacy
J Kenneth Coombes kcoombes
J Larry Barnett Ibamett
4 Fresence 10000 1000 HCSED Use
1-100f 13 records[10_JE Results per page Page oz > >
Apply | Cancel

Step 1  Select the desired user from the User Settings dialog box or use the
Search function to search for the user.

Step 2 Click the Pencil icon next to the desired user to edit their settings.
Figure 4-17 displays.

Figure 4-18 User Settings—Edit dialog box

MC550 Server

PBX Settings User Settings Quick Links

User Griffin, Brian Perzon Management

Connect to Call if answered after |8 | ¥| Seconds

Connect to Call if answered before |0 | Seconds
Caller id to be Displayed for Click to Call:

SMS Voice Mail Notification: T
MC550 Contact End Point:  Mobile Phone

RESERVED LINE LOCATION STATUS OVERRIDES

Dial 2142620150 /2500; [AtLunch =]
Dial 2142620151 /2501 |Away fromDesk =
Dialz142620152 /2802 [Busy =]
Dial 2142620153 /2503: [Gone Home =]
Dial 2142620154123457 /250¢: | On Business Trip =
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Step 3 In the Connect to Call if answered after text field, select the desired
amount of time from the drop-down list.

Step 4 Inthe Connect to Call if answered before text field, select the desired
amount of time from the drop-down list.

Step 5 Click to select the SMS Voice Mail Notification option. This option will
send a SMS message to the mobile user when the message waiting light
of their primary extension is on.

Step 6 The Reserved Line Location Status Overrides can be changed by
selecting the desired status from the drop-down list for each number
listed.

Step 7 Click Apply to save the changes or Cancel to exit the dialog box without
saving the changes.

To change the message under the Quick Links, select Application Data from the
OW5000 menu. Refer to the OW5000 Configuration Guide for more information.

Location Status Information/Message Settings

UC700 users are able to multi-ring their mobile phone by creating
contact rules using UC700. However, for non-UC700 users, you will have
to define a default Presence Status that will enable multi-ringing of their
mobile phone.

Follow the steps below to configure the Location Status Information
(LSI) settings and the Message Settings.

Step 1 From the OW5000 Platform Main Menu (Figure 4-2), select
Applications > Location Status Information (Figure 4-19). Step 2
displays.

Figure 4-19 Location Status Information

Platform
A Sed
Applications coess Server
ACD
Directory

Application M Servi
Application Data pplication Message Service

Setfings Dialer
Scheduler Email Nofification

I ing Call Assistant
e ncoming ssistan

Location Status Information

MA4000 Integration

Version Information IAC350 Server

OAl Server
Remote Call Control

Step 2 Select Message Settings. Figure 4-20 displays.
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Figure 4-20 LSI—Message Settings dialog box

Location Status Information

Server Settings Message Settings PBX Settings

Add New Message
-10ct12records [10 |@Results per psge Pagef1 |@ *oEE Defautt Onine: | Available ]v
Default Offline: i -I
SIP Presence offine
; 7 e Defaultldle: | Away from Desk =
i ne) Defautt Busy: i -
¢ Y. |In a Meeting
;? T Default Qut of Office |Out OF Office 'vI
;; ji[‘ Defautt DTerm: m
! ']_I' Default Mobility:  [-Not Set- -
;e
:? . Mot Set
/g At Lunch
f T Avallable
ﬂ = eak Away from Desk
L Busy
;,‘7 Ly biz_trip Gone Home
In & Mesting
f12rex B Resul = Page
Offline
On Break
A - On Business Trip
on Vacaion
Qut Of Office
Undisclosed

Step 3 Select the desired status to be set for Default Mobility, or add a new
status for the default mobility. When deciding whether to add a new
status or not, consider the following:

All the system-wide presence settings on the left are available to be
assigned to Default Mobility in the drop-down box. Once assigned, if a
non-UC700 MC550 user has a matching presence status, and someone
calls their primary desk extension, then their Mobile Phone will ring also.
This assumes that the MC550 user has been assigned a Mobile Phone
number by the OW5000 Administrator.

Note that this Default Mobility setting is global for all non-UC700 MC550
users. Thus, multi-ringing will only work for these users if they have a
presence status that matches what is assigned on this page. Also note
that multi-ringing will only ring the Mobile Phone number for non-UC700
MC550 users. No other defined external numbers will be rung.

The default status for non-UC700 users is "Offline". A non-UC700 user
can change their status a couple of ways. One is by assigning the user
an LSI button on their phone to allow them to change their status. The
other way is for the user to login to the MC550 web page and change
their status on the web site.

If non-UC700 MC550 users will not be granted access to change their
status, then one should assign the status "Offline" to the Default Mobility
field. With this setting, if non-UC700 MC550 users are unable to change
their status, then their mobile phone will ALWAY'S ring when their desk
phone is rung.

Users may want more control over when multi-ringing is enabled. To
accomplish this one would create a new system presence status. One
needs to do this because this Default Mobility setting is global, and one
user may feel that a presence status of Available should enable multi-
ringing of their cell phone, while another user does not. So to avoid
confusion one should create a new presence status that clearly means
that MC550 functionality is enabled. Then one would give users the
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ability to change their status with either an LSI key on their desk phone,
or by logging into the MC550 Website.

Step 4 Click Apply.

Starting the Services

Step 1  To start the server from your desktop, select Start > Programs >
Administrative Tools > Services. Figure 4-21 displays.

Figure 4-21 Services dialog box

File  Action  View Help

e ElEc = B> nn

Services (Local) £} Services (Local)

NEC MC550 Client Service Name_ = Deseription | Status Startup Type [ LogOnés |

ChMicrosoft ISCSL Init... ManagesT... Manual Local System
Stop the service S Microsoft Software ... Manages s, Manual Local System
Restart the service ) Manual

ikimedia Class Sc...  Enabl

0 Client: ..., Automatic

€ MCSS0 Server  NEC MC
C OWAgentService NEC OWAg.. Started  Automatic Local System
t.Msmq Listener ... Receives a.. Disabled Hetwork 5...
t.Pipe Listener A.., Receivesa.. Started  Automatic Local Service
t.Tcp Listener ... Recelvesa.. Started  Automatic Local Service
t.Tcp Port Sharin... Providesa,.. Started  Manual Local Service
tiogon Maintains a... Manual Local System
twork Access Pr...  Enables He... Manual Hetwork S...
twork Connections Manageso... Started  Manual Local System
twork List Service  Identifiest.. Started  Automatic Local Service
twork Location A... Collects an...  Started  Automatic Hetwork 5...
twork Store Inte.., This servic,. Started  Automatic Local Service
ine Fllss The Offline... Disabled Local System
W Dialer OWDidler  Started  Manual Aadminist. .
W OATMonitor OWSDO0 O... Starked  Automatic A\Administ. .
W Scheduler OWSO00S... Started  Manual Aadminist. .
WS000 Applicatio... Frovidesre... Started  Manual Local System
WS000 UCConfer.., Allows UC7... Started  Manual Local System
WhccessServer  OWAceess... Started  Automatic Local System
WCallNotificationAPT OWS000 C... Disabled Local System
WDBSync OWSDO0D... Starked  Automatic Local System
o

Y musenenic ., At~ bt s

Step 2 Right-click on the MC550 Server and select Start.

Description: Starked Automatic

MEC MCSS0 Clisnt Service

The service will start automatically after the initial installation.

Step 3 Right click on the MC550 Client service and select Start.

Configuring MC550 Users

MC550 users can use contact rules to determine when calls should
Multi-ring to their contact methods.

If a MC550 user is also a UC700 user, they will always use contact rules.
If a MC550 user is not a UC700 user, they can select whether or not to
use rules on their MC550 Call settings page. Once the system is
running, it may take several minutes for new users to become
operational.

Each user must be allowed access to the application. The following
topics are included in this section.
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User Configuration

Step 1 Login to the OW5000 Administrator by following the steps in “Logging
into OW5000 Administrator” on page 4-2.

Step 2 From the OW5000 Platform Main Menu (Figure 4-2), select Directory >
Users to display Figure 4-22. This option allows you to manage user
information, and to add or change application and role privileges.

Figure 4-22 Directory—User Management dialog box
User Management

SEARCH USERS Quick Links

= | Starts With

Filter By: | Last Name

isab

led

ver expires

Employee Name: [10

APPLICATIONS AND ROLES

I DBTool - Import/Export OWS5000 Dats | DbTool User

I ows000 Fiatfs Wb Directory

I Frocedurs Manager Administrator

I uAS200 On-Call

T UAS200 Room Dirsct
IF UAS200 S=rver
IE ucToo

Il UGE Emergency On-Site Notification | £-

T wiske-Up

Step 3 Select the desired user or use the Search Users option. In the
APPLICATIONS AND ROLES section, check Mobile Client and then
select MC550 User from the drop-down list.

Step 4 If this user is also to use UC700, verify that UC700 is also selected in the
APPLICATIONS AND ROLES section.
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Contact Methods

If a user is not using rules, they have a Mobile Phone Contact when in
Default Mobility Status. Follow the steps below to add a Mobile Phone
contact method and a Dual Mode Number.

Mobile Phone Contact Number

Step 1 From the OW5000 Platform Main Menu (Figure 4-2), select Directory >
People to display a list of persons. Find the correct person and click the
Pencil  icon next to the desired user to edit.

Step 2  Select the Contact Methods tab. Figure 4-23 displays.

Figure 4-23 Contact Method—Mobile Phone dialog box

Person Management

90 Current: test, Deepa

Contact Methods Addresses

Person

Add New Contact Method

Contact Method Method
ﬂﬁ Primary Extension 1000

Step 3 If a Mobile Phone does not appear as a contact method, click the Add
New Contact Method button.

Step 4 Select Mobile Phone as the contact method and enter the desired
Number of the Mobile Phone.

Step 5 Click Apply.
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Dual Mode Contact Number

gonss This is only needed for uMobility users.

NOTE

Figure 4-24 Contact Method—Dual Mode Number dialog box
Person Management

OWS5000 > Directory » People » Contact Methods Quick Links.

Exte

aﬁ Current: 10000, Presence

- Contsct Methoo: [RIINEIEN -
* Priority: || -1
- PEx Name [Select = FBX -

* Extension

Confidentiality Status: IN one |
(oo

Step 1  Select the Priority number and the PBX from the drop-down list.

Step 2 Enter the Extension number for the Dual Mode number and the desired
Confidentiality Status.

Step 3 Click Apply

Configuring Extensions

paad Extensions must be configured for all users.

When a user receives a call on their external number, the MC550 Server
will attempt to send the calling number. This means that for calls from
internal extensions, the MC550 will attempt to send a full call back
number, not merely the extension. In order for the MC550 Server to do
this, the OW5000 database should be populated such that every
extension reachable from outside be associated with a call back number.

The following steps must be completed to assign a DID number to an
extension. Do this for each extension in the database.

Step 1 From the OW5000 Platform Main Menu (Figure 4-2), select Platform >
Extensions. Figure 4-25 displays.
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Figure 4-25 Extension Management dialog box

Extension Management

e
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Step 2 Click the Pencil 4 icon on the desired extension to display Figure 4-26.

Figure 4-26 Extension Number dialog box

Extension Management

“Extension: #
-Fex [aPEX 7]
= PhoneType Im
* Tenant m

Country: IUnitl:—d States of America {1} j

DID Mumber. |

telURL | m
sIPURL | m
SIF Acoess Semver [Not Asmigned 7]
Collaboration [0 ’—ﬂ

Is Monitored: [T

There are no sublines defined,

Step 3  Enter the number in the DID Number field. Continue until all extensions
are configured.
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Advanced OW5000 Configuration

This chapter describes the advanced configuration for the MC550 Web
Site.

Securing a Connection

By default, the MC550 Web Site connection to the OW5000 is not
secured. In other words, the data that flows between them is not
encrypted.

If one were able to capture data packets in this flow (a difficult
proposition in an Ethernet switched environment, but not impossible),
then one would be able to discover an MC550 user's login and password
as well as view other data such as Current Status. This may or may not
be an issue in your private LAN; it depends on the security policy in your
organization and other safeguards put into place.

If your organization requires that the MC550 to OW5000 connection be
secure, OW5000 has the capability to use the security protocol TLS (also
known as SSL) to secure the connection. SSL provides confidentiality for
your MC550 data, including the login and password, by encrypting the
connection. In addition, SSL uses certificates so that the MC550 Web
Status Page will connect only to the correct OW5000 server and not to a
bogus server.

The following topics are included in this chapter:

Chapter Topics e Securing a Connection
e Server Certificate
e Configurations to Use a Secure Connection
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Server Certificate

Use the information below to obtain and install a service certificate.

Obtaining a Service Certificate for the OW5000

There are several ways to obtain a server certificate for the OW5000.
One method is described below and is based on instructions by
Microsoft. The instructions can be found at http://msdn.microsoft.com/
en-us/library/aa302411.aspx.

Follow the steps below to create a new certificate request, which can be
sent to a Certificate Authority (CA) for processing. If successful, the CA
will send back a file containing a validated certificate.

Step 1 To generate a certificate request, start Internet Information Services
(11S) Manager, expand the server, and then select Default Web Site.

Step 2 Right-click InfoAPIServices and click Properties. Figure 5-1 displays.

Figure 5-1 InfoAPI Services Properties

InfoAPIServices Properties ﬂ
HTTP Headers I Customn Errors I ASP.MET |
virtual Direckary | Dacuments Directory Security

- Authentication and access control
! ; Enable anonvmous access and edit the

authentication methods for this resource, |f

1P address and domain name restrictions

Grant of deny access to this resource using

@ IF addresses or Internet domain names.
Edit... |

[~ Secure communications
Fequire secure communications and i

enable dlient certificates when this SETVERCEIicate .y |
resource is accessed. _ -~

Wigw Certificate, ., |

Edit... |

o] | Cancel | Apply | Help |

Step 3 Click the Directory Security tab.
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Step 4 Click the Server Certificate button within Secure communications to
launch the Web Server Certificate Wizard and follow the instructions in
the Wizard.

The common name is one of the most significant pieces of information in the
——— cetrtificate. It is the name of the OW5000. If the certificate name doesn't match the
OW5000 name, the MC550 Web Site will not be able to connect to OW5000. If your
IMPORTANT OW5000 has a DNS name of "ow5000.abc-corp.com" and the MC550 web server
can resolve the DNS name to an IP address, then this name is what you should
specify for the common name. You may need to ensure that the internal DNS servers
have an entry for the OW5000 server.

Alternately, if your OW5000 has a NetBIOS name of "ABC-OW5000" and the MC550
web server can resolve the NetBIOS name to an IP address, then this name is what
you could specify for the common name.

Step 5 When the Web Server Certificate Wizard is complete, save the certificate
file when prompted.

This file should be sent to the Certificate Authority (CA). The CA then
uses your public key information from the certificate request to verify
information signed with your private key. The CA also verifies the
information supplied in the request.

The CA varies from organization to organization. It may be your
corporate IT group, or you may need to submit to a root CA company.
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Installing a Server Certificate on the OW5000 Server

After submitting the OW5000 certificate request to a CA, the CA returns
a server certificate for the OW5000. Use the following steps to install the
server certificate on the OW5000 server.

Step 1  Start IIS Manager, expand your server name, and select
InfoAPIServices.

Step 2 Right-click on InfoAPIServices and select Properties. Figure 5-2
displays.

Figure 5-2 InfoAPI Services Properties

InfoAPIServices Properties EH
HTTP Headers | Cuskarn Etrors | A5P.MNET |
virtual Direckory I Docurments Directory Security

—Authentication and access control

Enable anonvmous access and edit the
w authentication methads for this resource. |7

r~IP address and domain name restrictions

Grant of deny access to this resource using

@ IP addresses or Internet domain names.
Edit... |

[~ Secure communications
Require secure communications and 5 Certificat
enable client certificates when this Jarar CHrlicdiz,.
resource is accessed. _ -
Yiew Certificate, ., |
Edit... |

o] | Cancel | Al | Help |

Step 3 Select the Directory Security tab.

Step 4 Click Server Certificate to start the IS Certification Wizard.

Step 5 Select Process the pending request and install the certificate.

Step 6 Enter the Path to the certificate received from the CA and click Next.

Step 7 Leave the SSL port to the default of 443 and click Next. A Certificate
Summary displays.

Step 8 Click Next if it is correct.

Step 9 Select Finished.
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Testing a Certificate

If desired, test the certificate to be sure it is working. To test the

certific

ate, open a web browser on the MC550 Web Site server and

browse to the OW5000 INFOAPI URL; such as https://ow5000.abc-
corp.com/InfoAPIServices/Service.svc. If the page displays, the

certific

If the i
warnin
Do not
certific

ate has been installed successfully.

nstalled server certificate was not signed by a well-known CA, a
g displays that there is a problem with the OW5000 certificate.

be concerned because this warning will not display after the CA
ate is installed on the MC550 Web Site. The MC550 Web Site will

then be able to connect to the OW5000.

Figure 5-3 Certification Testing

ServiceImpl Service
You have created a service.

To test this service, you will need to create a client and use it to call the service. You can do this

This will generate a canfiguration file and a code file that contains the client class. Add the two files
to your client application and use the generated client class to call the Service. For example:

£

using the svcutil.exe tool from the command line with the following syntax:

svcutil.exe http://chola/InfoAPIServices/Service.svern

;i

Configurations to Use a Secure Connection

Configuring the OW5000 INFOAPI Web Site
Use the steps below to configure the OW5000 InFOAPI Web Site to use a

secure

Step 1

Step 2

Step 3

Step 4
Step 5

connection.

Open Windows Explorer on the OW5000 server and browse to the
Program Files\NEC\OW5000\INFOAPIS directory.

Right-click on the existing file web.config and rename it
web.nonssl.config.

Right-click on the existing file web.ssl.config and rename it to
web.config.

Save the changes and then close the file.

Restart the web site using 1IS Manager.
(re-start the default web site and default application pool; or if a separate
INFOAPI application pool is used, restart that pool).

InfoAPI should now be accessible using
https:\\localhost\InfoAPIServices\Service.svc.
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Maintaining the MC550 System

This chapter provides details on maintaining the MC550 system.

Log Viewer

Chapter Topics

Log Viewer is a utility in the UNIVERGE OW5000. OW5000 applications
generally log events to the OW5000 Log Server (OAI Monitor). These
logs are then stored into log file.

Log Viewer gives a system administrator the ability to:

e Connect to the OW5000 Log Server, display logged event, and change
the log level.

e Open .LOG files generated by the Log Server to query, filter, and
display their contents.

e Open the current log file which is created by the OW5000 Log Server
and display the Real-time log information.

The following topics are included in this chapter.
e [og Viewer Support Feature

e Starting Log Viewer
e Log Viewer Main Window

Log Viewer Support Feature

Log Viewer support features are different based on the environment and
the conditions.

There are two operating environment choices:

e Using Log Viewer on the OW5000 Platform installed server (Local).

e Using Log Viewer on a separate server from the OW5000 Platform
installed server (Remote).

There are two start-up modes available:
e Connecting with the OW5000 Log Server (Log Server)
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e Connecting with the OAL.LOG file
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Features

Query/Display current log file
(Standard Query)

Query/Display saved log file
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Filtering by text
(Standard Query)

Search by text
(Standard Query)

High light display
(Standard Query)

Day Light Saving adjustment
(Standard Query)

Display attached data
(Standard Query)

Print out event information
(Standard Query)

Save search result
(Standard Query)

Bookmark
(Standard Query)

Query/ Real-time Display current log
file (Real-time Query)

Filtering by text
(Real-time Query)

Search by text
(Real-time Query)

High light display
(Real-time Query)

Day Light Saving adjustment
(Real-time Query)

Display attached data
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Print out event information
(Real-time Query)

Save search result
(Real-time Query)

Bookmark
(Real-time Query)

Change Log Level
Maintenance Log File

Change Query Mode

Log Server

X
X
X
X

UCE Mobility (UNIVERGE MC550) Installation Guide - Revision 4

OALLOG Log Server




Maintaining the MC550 System 6-3

gonss Multiple Log Viewers can be used on the same server. However, it might be a
= problem when the Log Viewer configuration is changed. Therefore, do not change
any configurations while multiple Log Viewers are being used.

Starting Log Viewer

Log Viewer connects to the OW5000 Log Server (OAI Monitor) or the log
file which was created by the OW5000 Log Server.

Use the following steps to start Log Viewer:

Step 1 From the desktop, click the Start button, and then select All Programs >
NEC OW5000 > Runtime Platform > Log Viewer. A Connect to
OWS5000 Log dialog box displays (Figure 6-1).

Figure 6-1 Connect to OW5000 Log dialog box
ﬂ Laocation IDW5UUUSEWEI| j J Qunnectl

Enter the name of an 0W5H000 Log Server machine or a log
filename ko connect to

Step 2 In the Location field, type the name where the Log Server is to connect.

If this is a Local Server, type the OW5000 Platform computer name
where it connects to the OW5000 Log Server.

If this is a Remote Server, type the OW5000 Platform server IP Address
and port number (5690). For example, 127.0.0.1:5690. If the DNS is
available, the OW5000 Platform computer name is available even if itis a
remote server. You can also use the browse button (...) to select a log file
or use the drop-down list to display all previously opened machines and
.LOG files in the Location field. A Connect Failed dialog box displays if it
failed (Figure 6-2).

Step 3 Click OK and try again beginning with Step 2.

Figure 6-2 Connection Failed dialog box

Connect Failed [E3

Failed to connect,

Step 4 Click the Connect button, a Log Viewer Main Window displays if it is
connected successfully.
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Log Viewer Main Window

Starting the Log Viewer program displays the Log Viewer Main Window,
shown in Figure 6-3. Standard Query mode is applied when the Log
Viewer starts.

From the Log Viewer Main window, you can:

¢ Specify the applications that are displayed.

e Search the log files for specific information, including events, dates,
and text.

¢ View log file information.

¢ Print log file information.

e Save query results and bookmark them for easy access.

¢ In Real-time Query mode, Real-time event information displays.
¢ Change the application log level. Maintenance of log files.

e Change query mode between Standard Query mode and Real-time
Query mode.
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Figure 6-3 OW5000 Log Viewer Main window
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The Log Viewer window contains the following components:

Title Bar

6-5

Displays the name of the application and the name of the OW5000 Log
Server or log file to which Log Viewer is connected.

Figure 6-4 Log Viewer Title Bar

& DWS5000 Log Yiewer - karma

Menu Bar

The menu bar displays at the top of the Log Viewer window and contains
two pull-down menus: File and Help (Figure 6-5).

Figure 6-5 Log Viewer Menu Bar

MenuBar ——

& DW5000 Log Yiewer

File Help

Each menu item contains various menu options. Each menu item and its
corresponding menu options are described below:
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File Menu

The File menu options are Open Log, Print, Print Setup, and Exit. A brief
description of each option is listed below.

Figure 6-6 File Menu

Fil= Help
Open Log...  ChrH+O
Print... Ckrl+P
Print Sekup...

Exit

Open Log

Opens a dialog box which enables you to connect to a specified OW5000
Log Server or .LOG file. When connected to a Log Server, you can view
and configure its log parameters.

Print
Opens the Print dialog box and enables you to print the events that are
currently displayed.

Print Setup

Opens the Print Setup dialog box where you can select your printing
options.

Exit
Closes Log Viewer.

Help Menu

The Help menu option is About OW5000 Log Viewer. A description of
this option is listed below (Figure 6-7).

Figure 6-7 Help Menu

Help

About OWS000 Log Yiewer. ..
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As referenced in Chapter 4, detailed descriptions of each field in the PBX

Settings dialog box is explained below.

MC550 Server

PBX Settings L.Ise-rSe-tﬁn-gs
PBx [ Dansfiox =1

IP Address 1722413238
PEXID: 223
RII Bind Mame OaAlServernDans-Fox
Client Server Port 440132
PEX Typs: UNMIVERGE SWES00
Split Call Forward: Mo
Fort: S0020

Foroe Port Yes
Heartbeat Ves
Selected: ¥
Use ©al Server Mo
Data Moae: [122 1 Moot =]
LED Number [12] Mosiin[=]
i x

| (Default valus & min)

| tsuggested val

2 esecq)

1

=
28 | 1Suggested valus 15-40 sec)
SMFN Version: 5

| iDefault vslus 2)

Specisl Cutbound Disl Prefix |

Default Outbound Caller 1D |

Send Caller |D for Qutbcund Dial: F

Calling Mame Cverride from O

[At Cunoh -]

IA.VE} from Desk =]
[Busy =1
[Bone Home -]

|on Business Trip =

e Data Mode:

Set the Data Mode key that MC550 uses to communicate with Dterm
users by selecting an available Data Mode from the drop-down list.
The data mode you select must be programmed for use with OAI in
the PBX, and it must be assigned to a function key button (AKYD) on
each user's Dterm in order for the MC550 Move function to be
available to the user.

The value ranges from 128 to 191 and should match the OPCODE in
the AOKC command on the UNIVERGE SV8500, and command D7 on
the UNIVERGE SV8300.

LED Number:

Set the LED Number that the MC550 Move function lights when active
on the Dterm. This data directly relates to the KEY-CODE assigned in
the AOKC command on the UNIVERGE SV8500, and command D7 on
the UNIVERGE SV8300.
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e VMMA Short Timer (sec) and VMMA Long Timer (sec):
See “Setting the MC550 VMMA Timers” on page A-2 of this Appendix.
These can also be adjusted, on a per user basis, from the MC550
Application page by selecting the User Settings tab. For more
information, refer to “User Settings” on page 4-11.

e Special Outbound Dial Prefix:
This field can be used to force the MC550 to dial out to the mobile
contacts using a special dial code so as to force it to pick an ISDN or
SIP route in a mixed trunking environment. This would be a code that
was programmed in the voice server as an LCR code to a specific
route.

e Default Outbound Caller ID:
This is the caller ID sent to Mobile Contacts if no valid caller ID for the
calling part can be found.

e Send Caller ID for Outbound Dial:
Selecting this box tells the MC550 Server to pass the incoming or
database referenced caller ID out to the mobile contacts.

e Calling Name Override from Database:
This check box tells the MC550 to override the incoming name
provided by ISDN or voice system programming with the name
assigned in the OW5000 database, if found. This is used on outgoing
calls to mobile contacts for multi-ring cases.

Setting the MC550 VMMA Timers

The MC550 uses a combination of 3 timers for voice mail message
avoidance (VMMA).

e MC550 VMMA Short Timer
e MC550 VMMA Long Timer
e PBX Predictive Dial Timer

The VMMA timers are per user in MC550 R3.0.

-y -—

The MC550 VMMA Short Timer is used to avoid cellular voice mail when
the hand set is powered off or out of service. If the MC550 application
receives an answer signal from the outgoing trunk before the VMMA
Short timer expires, it assumes this was the cellular network voice mail
answering and releases the trunk, leaving the original call ringing on the
desk station.

The MC550 VMMA Long Timer is used to avoid the Cellular network voice
mail answering after the handset has been rung and does not answer. If
the MC550 Application receives an answer signal from the trunk after
this timer has expired, it assumes this is the cellular network voice mail
answering and releases the trunk, leaving the original call ringing on the
desk station.

The PBX Predictive Dial timer is used to make sure that an unanswered
call to a mobile contact always gets released after a set amount of time.
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This will avoid accidental trunk lockups if the application is shutdown or
if some failure is encountered. This timer is cleared as soon as the PBX
receives an answer signal from the trunk. This timer is automatically set
larger than the VMMA Long timer. It is a normal TC * MTC PBX timer and
has a fixed TC value of 8 seconds. MTC is the ((VMMA Long Timer / 8) +
1). As with all PBX timers, this timer will vary within 1 TC value. For
example, if the MTC is set to 3. TC * MTC = 24 so the timer would be a
range from 24 to 32 seconds.

These timers only affect calls that are answered by external contacts, not the primary
= extension.

In the following example, the MC550 VMMA Short timer is set to 5
seconds and the VMMA Long timer is set to 25 seconds. The PBX
Predictive Dial timer will be 32-40 seconds.

¢ Only calls answered in the Green area will result in a completed
mobile call.

e Calls answered in the Red or Orange area will be released by the
MC550 application because of VMMA detection.

e Calls that are not answered will be released by the PBX in the orange
area.

Os 5s 25s 40s
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MC550 Caller ID

How MC550 Caller ID Works

Listed below are important notes about trunk providers and cell
networks.

Trunk Provider

MC550 uses a variety of methods to find a number and a name to send
as the Caller ID when MC550 server calls an external number. However,
the trunk (ISDN or SIP) provider must not filter Caller ID to fully realize
Caller ID for MC550. Listed below are some typical issues that you may
need to resolve with your provider:

e The trunk is setup to send only the billing number for the trunk. In
this case the provider will send only this number as the caller ID,
regardless of what MC550 sends.

e The trunk is setup to send only numbers that belong to your business.
In this case, caller ID will work for calls from internal callers. But, for
calls from external numbers, the provider will send the billing number
for the trunk as the caller ID, regardless of what MC550 sends.

e The provider may be willing to provide exceptions to most businesses
to allow any number to be sent (by a signed agreement), but they are
unable to make an exception for you because the ISDN switch you are
connected to is unable to support this exception.

e The trunk may be setup to only send a predefined name as the Caller
ID name. The provider will send only this name, regardless of what
MC550 sends.
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Cell Networks

Most North American cell networks are not passing Caller ID names to
cell phones.

Important OW5000 Settings

The MC550 Server application settings include the following Caller ID
related fields.

Default Outhound Caller ID
Send Caller ID far Outhound Dial: W

Calling Name Override from Database:

Send Caller ID for Outbound Dial

Enable Send Caller ID for Outbound Dial for MC550 to provide a
calling name and number to the PBX for calls to MC550 external
numbers, such as an MC550 user's cell phone.

If Send Caller ID for Outbound Dial is not enabled, a number will not
be provided and either your trunk gateway or your provider will be
relied upon to send the Caller ID they have configured to send.

Default Outbound Caller ID

MC550 will make an attempt to find a DID to send as the calling number,
when Send Caller ID for Outbound Dial is enabled.

o If the caller is external, and Caller ID is received, the received calling
number will be sent as Caller ID.

e If the caller is internal, and there is a DID associated with the caller,
the DID will be sent as Caller ID.

If a number is not found to be sent, the Default Outbound Caller ID
will be sent as the Caller ID.

Calling Name Override from Database

The Calling Name can come from an external callers' received Caller ID,
or it can come from an internal caller's PBX assigned name. However,
when Calling Name Override from Database is enabled, the name in
the OW5000 database that is associated with the calling number will be
sent instead as the Caller ID.
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Associating a DID with an Internal Caller

To associate a DID with an internal caller in OW5000, configure DID
Number for the calling number in Extension Management. Generally
this would be done for every employee extension in the OW5000
database.

0ID Mumber | |

Call Scenarios and Caller ID

Red calls Black (MC550 user) which multi-rings Black's cell number:

Red Phone Display on Red Caller ID sent to Black’s cell

Ringing: Black’s extension

Internal Dterm Answered: Black’s cell number |Red’s DID
(Note)
External phone Black’s extension’s DID Red’s number

Note: PBX-Dterm limitation

Red calls Black (MC550 user) which multi-rings another Station:

Display on the multi-rung

Red Phone Display on Red Station
Ringing: Black’s extension If Dterm: MC550 Monitor number
Internal Dterm Answered: Black’s cell number | (Note)
(Note) If SIP Station: Red’s DID
External phone Black’s extension’s DID Red’s number

Note: PBX-Dterm limitation
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Black (MC550 user) uses MC550 Website to call Red from Black’s cell

phone:

y

Red Phone

Internal Dterm

External phone

—-

Display on Red

Ringing: Black’s
extension

Answered: Black’s cell
number (Note 1)

Note 1: PBX-Dterm limitation.
Note 2: This is design intent. That way you know that the inbound call was initiated by you and not Red.

Note 3: The MC550 user can override this by configuring a custom Caller ID number, as show in Figure
B-1. Sending a custom Caller ID can be useful for scenarios such as when helpdesk employees call
external customers with Click-to-Call and want to send the main helpdesk number as the Caller ID.

Caller ID sent to Red

Black’s extension’s DID
(Note 3)

Caller ID sent to
Black’s cell

Black’s extension’s DID
(Note 2)

Black’s extension’s DID
(Note 2)

Figure B-1 MC550 Website Call Settings

Call Settings

SMS Voice Mail Motification

Connect The Call if Answered After:
Connect The Call if Answered Before:

Caller ID To Be Displayed for Clide-to-Call:

Enable [¥] (2147227028 @0 attnet) )
4 (Defaut)| ¥ | seconcs

22 (DBfEUlT} |E| seconds
2142626000
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Proving what Caller ID is Sent

Inspect the MC550 Server debug log. When MC550 server multi-rings
an external number, you will see an SCF128_REQ command in the log
similar to the following:

{INFO}... SCF128_REQ : 14600 -> 9815558221509, ", 5555774200, 5
This is a command from the MC550 telling the PBX to:

dial from the monitor number 14600

dial the number 555-822-1509

send nothing as the calling name (
send)

send 555-577-4200 as the calling humber.

means no name was found to

With such troubleshooting you should be able to prove whether the
provider is filtering Caller ID.

UCE Mobility (UNIVERGE MC550) Installation Guide - Revision 4



B-6 MC550 Caller ID

UCE Mobility (UNIVERGE MC550) Installation Guide - Revision 4



For additional information or support on this NEC Corporation of America product,
contact your NEC Corporation of America representative.



NEC NEC Corporation

UC for Enterprise (UCE) Mobility (UNIVERGE MC550)
Installation Guide

NDA-31000, Revision 4



	Title Page
	Liability Disclaimer
	Contents
	Figures
	Tables
	1 - Introduction
	MC550 System Overview
	MC550 User Types Overview
	MC550 Users Using Contact Rules
	MC550 Users Not Using Contact Rules

	How This Guide is Organized

	2 - Requirements
	OW5000 Platform Requirements
	MC550 Server Requirements
	MC550 Web Site
	PBX Requirements
	PBX Trunking Requirements
	PBX OAI System Requirements

	LAN Requirements

	3 - Installing the MC550 System
	Before Installing the MC550 Software
	PBX Configuration for MC550
	SV8500 System Programming
	SV8300 System Programming
	Installing the MC550 Server Software
	Activating the MC550 Server Software
	Upgrading the MC550 Server

	Installing the MC550 Web Site
	Securing the MC550 Web Site
	Upgrading the MC550 Client
	Uninstalling the MC550 Client


	4 - Configuring the MC550 System
	Configuring the MC550 Server in OW5000 Administrator
	Logging into OW5000 Administrator
	Assigning a PBX / Monitored Numbers
	Assigning a PBX / Mobility UCD Member
	Assigning a PBX / Mobility UCD Pilot
	MLSO Reserved Numbers
	MC550 Server Settings
	Location Status Information/Message Settings
	Starting the Services

	Configuring MC550 Users
	User Configuration
	Contact Methods

	Configuring Extensions

	5 - Advanced OW5000 Configuration
	Securing a Connection
	Server Certificate
	Obtaining a Service Certificate for the OW5000
	Installing a Server Certificate on the OW5000 Server
	Testing a Certificate

	Configurations to Use a Secure Connection
	Configuring the OW5000 INFOAPI Web Site


	6 - Maintaining the MC550 System
	Log Viewer
	Log Viewer Support Feature
	Starting Log Viewer
	Log Viewer Main Window
	File Menu
	Help Menu


	Appendix A - MC550 Server PBX Settings Details
	Setting the MC550 VMMA Timers

	Appendix B - MC550 Caller ID
	How MC550 Caller ID Works
	Trunk Provider
	Cell Networks
	Important OW5000 Settings
	Associating a DID with an Internal Caller
	Call Scenarios and Caller ID
	Proving what Caller ID is Sent



